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Center Server is the central management component in a vSphere
environment. Without vCenter Server, ESX and ESXi hosts are
simply hypervisors with the ability to run virtual machines, commonly

referred to as guests. When coupled with appropriate host licensing,
vCenter Server can significantly extend the capabilities of the ESX and
ESXi hosts it manages. Some of the extended capabilities that vCenter
Server includes are VMotion, Storage VMotion, High Availability, and
Distributed Resource Scheduling. Keep in mind that vCenter Server
does not enable these features but rather leverages these capabilities
when hosts are assigned licenses that include those features.

You should become familiar with vCenter Server’s requirements
as well as the proper installation method. A well-configured vCenter
Server installation provides a solid administrative platform to manage
vSphere to its fullest potential.

Prepare for Installation

One of most important components of the vSphere environment is vCen-

ter Server. vCenter Server acts as a central management point for man-

aging ESX and ESXi hosts, and additional components like the Guided

Consolidation Service, vCenter Update Manager, and user permissions.
Installing vCenter Server can be broken into three steps.

1. Ensure that your system is capable of running vCenter Server.
2. Install vCenter Server and any additional components.

3. Perform basic configuration of vCenter Server and some addi-
tional components.

As of this writing, vCenter Server is available only for Microsoft
Windows systems. This has been a sore subject for administrators in IT
shops that primarily run operating systems other than Windows. VMware
has listened, and currently there is a technical preview of vCenter Server
for Linux, available for download at http://www.vmtn.net/ as a virtual
appliance.

vCenter Server must operate on the Microsoft Windows platform.
What else does it require? To ensure that vCenter Server can accommo-
date the performance necessary to efficiently manage ESX and ESXi hosts,
VMware has provided some preliminary requirements for the hardware,
operating system, and database required to support vCenter Server.
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Identify Hardware Requirements

VMware vCenter Server can be installed on a physical or virtual
machine that meets the requirements listed in Table 3.1

Table 3.1: Hardware Requirements

Component Requirement

Processor 2.0GHz or greater Intel or AMD x86 based processor. It is a best practice to
use a faster processor if the vCenter Database runs on the same server.

Memory 2GB of RAM. Again, it is a best practice to use more RAM if the data-
base is running on the same server.
The VMware vCenter Management Webservices require from 128MB to
1.5GB of additional memory. The memory is allocated at system startup.

Database A minimum of 1GB of additional storage is required in addition to the
storage required for the operating system installation.
If the VMware vCenter Update Manager service is installed on the same
system, an additional 22GB of space is required to accommodate storage
of patches.
If Microsoft SQL Server 2005 Express is installed as the database, 2GB
of disk space is required during the installation, with 1.5GB reclaimed
after the installation is complete.

Networking A 100MB network connection can be used, but a 1GB network connec-
tion is recommended.

Meeting these requirements will ensure proper operation of vCenter
Server and any additional components. When designing the environment,
give additional thought to future growth or scalability of vCenter Server.

Identify Operating System Requirements for vCenter
Server and vSphere Client

Due to the fact that vCenter Server was developed to operate on a
Windows platform, VMware supports this product on only a limited
number of operating system configurations. Some operating systems,
such as Windows 2000, are no longer supported, or are referred to as
end of life, while others, such as 64-bit versions, are not yet supported
100 percent natively. Additionally, some operating systems were not
originally designed for this type of workload, such as Windows 2003
Web Edition. Table 3.2 lists the operating systems for which VMware
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vCenter Server is supported, their versions, and supported Internet
Protocol modes.

Table 3.2: Operating System Requirements for vCenter Server

Mixed IPv4 and
Operating System IPv4? IPv6? IPv6?
Windows XP Pro (SP2 or greater, x86) Yes Yes
Windows 2003 Server (SP1 or greater x86) Yes Yes
Windows 2003 Server R2 Yes Yes
Windows 2003 Server x64 Yes Yes
Windows Server 2008 x86 Yes Yes Yes
Windows Server 2008 x64 Yes Yes Yes

VMware has tested the operating systems in Table 3.2 and certified
their use for vCenter Server. Older operating systems, such as Windows
NT 4.0, Windows 2000, and Windows 2003 without any service pack,
have failed to meet the minimum requirements of vCenter Server.

To manage VMware vCenter Server, you use vSphere Client to
configure, manage, and monitor the environment. vSphere Client was
developed using Microsoft .NET technologies and is also limited to
Microsoft operating systems. Table 3.3 lists the operating systems on
which vSphere Client may be installed to manage a vCenter Server.

Table 3.3: vSphere Client System Requirements

Mixed IPv4 and
Operating System IPv4? IPv6? IPv6?
Windows XP Pro (SP2 or greater, x86) Yes No Yes
Windows XP Pro (SP2 or greater, x64) Yes No Yes
Windows 2003 Server (SP1 or greater x86) Yes No Yes
Windows 2003 Server R2 Yes No Yes
Windows 2003 Server x64 Yes No Yes
Windows 2003 Server Standard and Web Yes No Yes

Edition x86 or x64
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Mixed IPv4 and

Operating System IPv4? IPv6? IPv6?
Windows Vista Business with SP1 Yes Yes Yes
Windows Vista Enterprise with SP1 Yes Yes Yes
Windows Vista Business with SP1 x64 Yes Yes Yes
Windows Vista Enterprise with SP1 x64 Yes Yes Yes
Windows Server 2008 x86 Yes Yes Yes
Windows Server 2008 x64 Yes Yes Yes

There are also some best practices with regard to the domain mem-
bership of a server running vCenter Server. Following these guidelines
will ensure installation and operation run more smoothly:

= Microsoft strongly recommends that vCenter Server be joined to
a Microsoft Windows domain. This will provide better security
and domain capabilities to services that require it.

= vCenter Server 4.0 adds the ability to use distributed vCenter
Servers, referred to as Linked Mode vCenter Servers. If you are
using Linked Mode vCenter Servers, the individual vCenter Servers
may be in different domains, provided there is a two-way trust

between the two domains.

In addition to vSphere Client, vSphere Web Access may be used to
manage the vCenter Server installation, and it has some minimum
requirements as well. The following browsers have been tested by
VMware to verify proper operation of vSphere Web Access:

Microsoft Windows Internet Explorer 6.x

Microsoft Windows Internet Explorer 7.0

Mozilla 1.x for Windows/Linux
Mozilla Firefox 2.0.x
Mozilla Firefox 3.0.x

Ensuring that the hardware and software requirements are met will
ensure that the configuration used for vCenter Server, vSphere Client,
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and vSphere Web Access will provide a trouble-free installation and
management platform for the vSphere environment.

Identify Database Requirements

At the heart of VMware vCenter Server and its ancillary components lie
a number of databases. Separate databases are recommended for vCen-
ter Server and ancillary components, such as vCenter Update Manager,
although it is not required for each additional component to be installed
using a separate database. Separate databases add levels of separation
of the data and can result in better performance levels. These databases
do not have to be on the same machine as vCenter Server, nor do they
have to reside on the same remote server. It is possible to have a vCen-
ter instance installed on one server, with its SQL database residing on
another server, while having the vCenter Update Manager database on
a third server. The choices are wide and depend on your operational
needs. The default installation will load vCenter and required databases
on the same system. The vCenter Server installation routine includes
Microsoft SQL Server 2005 Express Edition.

If you accept the defaults, the instance of Microsoft SQL Server 2005
Express that is bundled with vCenter Server is used, and user authenti-
cation defaults to the rights of the user account performing the installa-
tion. If another supported database is used, administrative credentials
are required.

NOTE Although not required, as a best practice, ensure that the
database service on either the local or remote machine is also run-
ning as a domain account to aid in authentication if you are using
any edition of Microsoft SQL Server 2005.

The following databases are supported for vCenter Server and vCen-
ter Update Manager installations.

= Microsoft SQL Server 2005 Express

= Microsoft SQL Server 2005 Standard Edition SP2

= Microsoft SQL Server 2005 Enterprise Edition SP2

= Microsoft SQL Server 2005 Enterprise Edition SP2 x64
= Microsoft SQL Server 2008 Standard Edition
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= Microsoft SQL Server 2008 Enterprise Edition

= Microsoft SQL Server 2008 Enterprise Edition x64

= Oracle 10g Standard Edition, Release 1 (10.1.0.3.0)

= Oracle 10g Enterprise Edition, Release 1 (10.1.0.3.0)

= Oracle 10g Standard Edition, Release 2 (10.2.0.1.0)

= Oracle 10g Enterprise Edition, Release 2 (10.2.0.1.0)

= Oracle 10g Enterprise Edition, Release 2 (10.2.0.1.0) x64
= Oracle 11g Standard Edition

= Oracle 11g Enterprise Edition

Identify Networking Requirements

Because vSphere is not a single stand-alone server, application, or iso-
lated computing system, the pieces of the puzzle will require some form
of communication between them. There are many possible configura-
tion scenarios depending on the environment in which vSphere is being
deployed.

A vCenter Server must be able to communicate with each host and
each vSphere client. Furthermore, if a remote database server is utilized
rather than a local instance of the database, the required TCP/IP ports
for that database installation are also required.

If an instance of vCenter Server is installed on Windows Server
2008, you must either disable the Windows Firewall or make an excep-
tion to allow communication between all of the required pieces of the
environment.

vCenter Server requires several ports to be open when you select
a default installation. Each of these ports will be used for a different
portion of the overall communications path. To enable proper commu-
nication between each of the components, consult a network engineer to
ensure the appropriate ports are open for communication.

Web ports that are required to be open include the following;:

= Port 80 is required for the purpose of redirecting nonsecure
requests to vCenter Server on a secure port.

= Port 443 is the default port used to communicate with vSphere
Client and to look for data from vSphere Web Access Client and
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other VMware Software Development Kit (SDK) applications
such as the VI Toolkit. You can change this port, but vSphere
Client and any SDK applications must use the vCenter Server
name, followed by the nondefault port number.

= Port 8080 is the port used by Web Services HTTP.
= Port 8443 is the port used by Web Services HTTPS.

Directory Services ports that are required to be open include the
following:

= Port 389 is the standard port number used for Lightweight
Directory Access Protocol (LDAP) services. This port is used for
the Directory Services component of vCenter Server. It must be
available to vCenter Server, even if vCenter Server is not part of a
Linked Mode Group. You can change from port 389 to any avail-
able port ranging from 1025 to 65535. This is the normal LDAP
port that the vCenter Server Active Directory Application Mode
(ADAM) instance listens on.

= Port 636 is also used when using vCenter in Linked Mode. This
is the Secure Sockets Layer (SSL) port of the local vCenter Server
ADAM Instance. It is the preferred port number, but it can also be
changed to any available port ranging from 1025 to 65535.

Host and client ports that are required to be open include the
following:

= Port 902 is used for multiple tasks. It is used to manage ESX and
ESXi hosts and send data to them. vCenter Server also receives a
heartbeat at regular intervals from hosts on port 902 over User
Datagram Protocol (UDP). This port must not be blocked between
vCenter Server and hosts, or between hosts. Port 902 is also used
for providing remote console access to virtual machines from
vSphere Client.

= Port 903 is used in the same fashion as 902: it provides remote
console access of virtual machines to vSphere Client. These ports
must be open for proper communication to occur between vCen-
ter Server and vSphere Client, as well as from vSphere Client and
the ESX and ESXi hosts.
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Identify Authentication Requirements

Initial authentication in vCenter Server is handled through local

user accounts on the system that vCenter Server is installed on.
Authentication to managed ESX and ESXi servers is handled through
vCenter Server as hosts are added to the vSphere configuration.
Additionally, local accounts on each host may be created. Accounts
local to ESX and ESXi hosts do not have permissions in the vCenter
Server interface, even though they may have elevated privileges at the
host level.

Install a Database

As previously mentioned, VMware utilizes industry-standard databases
for vCenter Server. Administrators cannot easily use or access the raw
data contained in the vCenter Server database; instead, they must use
vSphere Client. Components like the datacenters, clusters, resource
pools, hosts, and virtual machines, along with their associated configu-
ration and performance data, are stored in the backend database that
vCenter Server is connected to. As mentioned, the default installation
includes Microsoft SQL Server 2005 Express Edition. The vCenter
Server installer automatically creates a data source name (DSN), the
database, and the database schema when using the embedded SQL
Server 2005 Express. We’ll cover installation of the default database
when we discuss vCenter Server installation.

We will examine a few alternate database installations—Microsoft
SQL Server 2005 (other than Express Edition) or Oracle 10g or 11g—in
the following sections.

Create a vCenter Database in Microsoft
SQL Server 2005

The default Microsoft SQL Server 2005 Express Edition installation
with vCenter Server supports up to 5 hosts and 50 virtual machines. It
is not considered as robust as its cousins, Microsoft SQL Server 2005
Standard and Enterprise Editions. In many cases the Standard and
Enterprise Editions are chosen due to their enhanced feature set, which
they do not share with the Express Edition.
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Tables listing the differences among the various editions of Microsoft
SQL Server 2005 can be found on Microsoft’s website:

http://www.microsoft.com/Sqlserver/2005/en/us/
compare-features.aspx

Whether you have chosen to utilize Standard or Enterprise Edition,
Microsoft recommends certain configuration settings when you’re creat-
ing the vCenter Server database. The database can reside on the local
system or can be accessed remotely. This database can be created auto-
matically using the SQL 2005 management tools. Using the automatic
method will require some additional configuration. To accomplish this
easily, use the following steps:

1. If vCenter Server is part of a Windows domain, create a domain
account that will be used to access the SQL Server instance.

NOTE Itis not a best practice to use a Domain Admin account
for this purpose but rather a dedicated domain account. Make sure
this user has db_datawriter and db_datareader permissions on the
SQL instance.

2. During initial installation and upgrades, the vpxuser account
must have db_owner rights on the MSDB database. This access
can be revoked after an installation or upgrade.

3. Load SQL Query Analyzer with a user that has DBO privileges,
and run the following instructions:

use [master]

go

CREATE DATABASE [VCDB] ON PRIMARY

(NAME = N'vcdb', FILENAME = N'C:\VCDB.mdf' , =
SIZE = 2000KB , FILEGROWTH = 10% )

LOG ON

(NAME = N'vcdb_Tlog', FILENAME = N'C:\VCDB.ldf' , =
SIZE = 1000KB , FILEGROWTH = 10%)

COLLATE SQL_Latinl_General_CP1_CI_AS

go

use VCDB

go
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sp_addlogin @loginame=[vpxuser], @passwd=N'vpxuser', =
@defdb="'VCDB', @deflanguage='

o B
go = E
ALTER LOGIN [vpxuser] WITH CHECK_POLICY = OFF é g
go S 2
© w
CREATE USER [vpxuser] for LOGIN [vpxuser] =
go 5 2
.E ‘g.
sp_addrolemember @rolename = 'db_owner', = [ I
@membername = 'vpxuser' m
go
use MSDB
go
CREATE USER [vpxuser] for LOGIN [vpxuser]
go
sp_addrolemember @rolename = 'db_owner', =
@membername = 'vpxuser'
go

Remember that you can change the database user, location, and
database name within this script. Keep in mind that these values
will need to match the DSN created to access the database.

4. Use the same SQL Query Analyzer window to run the following
scripts in the order they are listed. These scripts, which create the
database schema, can be located and run from the vpx/dbshema
directory of the installation media.

VCDB_mssq1.SQL
purge_statl _proc_mssql.sql
purge_stat2_proc_mssql.sql
purge_stat3_proc_mssql.sql
purge_usage_stats_proc_mssql.sql
stats_rollupl_proc_mssql.sql
stats_rollup2_proc_mssql.sql
stats_rollup3_proc_mssql.sql
cleanup_events_mssql.sql
delete_stats_proc_mssql.sql

5. There are some additional scripts that work with the SQL Server
Agent to handle job scheduling and similar tasks. They are not
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supported when you’re using Microsoft SQL Server 2005 Express
Edition, as that edition does not natively provide any scheduling
functions. Again, using the same SQL Query Analyzer, load and
run each of these scripts in the order listed. Before running the
scripts, confirm that the SQL Server Agent is running.

job_schedulel_mssql.sql
job_schedule2_mssql.sql
job_schedule3_mssql.sql
job_cleanup_events

6. The database and database schema have now been created and are
ready for a DSN to connect to the VCDB instance.

7. On the vCenter Server system, open the Windows ODBC Data
Source Administrator by choosing Settings > Control Panel >
Administrative Tools > Data Sources (ODBC).

NOTE If you're using a 64-bit operating system, you are
required to run the 32-bit ODBC Administrator application, which
is located at C:\Windows\SysWOW64\odbcad32.exe.

8. Select the System DSN tab.
9. Click Add, select SQL Native Client, and click Finish.

10. Type an ODBC DSN name in the Name field, something like
vCenter Server.

11. Select the server name from the Server drop-down menu and click
Next. This can be the local system or a remote system.

NOTE With a default installation of SQL Server, only a single
instance or installation of SQL is present. If multiple SQL Server
installations are present on a server, each additional installation is
referred to as a named instance.The primary instance does not
have a specific name, other than the server name, while named
instances are typically signified as SERVERNAME\ InstanceName.

12. Type the SQL Server machine name in the Server text field (or
select it from the Server drop-down list).
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13. Select Windows Authentication.

14. Select the database created for the vCenter Server system from the
Change The Default Database To menu and click Next.

15. Click Finish.

A DSN that is compatible with vCenter Server is now available. When
the vCenter Server installer prompts for the DSN of the database, select
vCenter Server, or whatever value you entered in step 10.

Microsoft SQL Server 20035 is a popular database, and as you can see
in steps 1 through 13, it is relatively simple to configure.

Create a vCenter Database in Oracle

Not every environment uses Microsoft SQL Server 200S5. For various
reasons, administrators are often forced to choose databases already
being used in their environment. Oracle is a popular database choice,
and VMware supports several versions of Oracle, including 10g and
11g. Oracle has another appeal to environments that have a limited
Microsoft footprint: it is available for many other platforms, including
Linux, Solaris, and HP-UX. You don’t have to have Oracle installed
locally on the vCenter Server. Just as with Microsoft’s database offer-
ing, when you’re using Oracle, certain configurations are considered
best practices when creating the database. Perform these steps to create
the database:

1. Logon to a SQL*Plus session with the system account.

2. Run the following commands, or script, to create the database:

CREATE SMALLFILE TABLESPACE "VPX" DATAFILE
'/u01/app/oracle/oradata/vcdb/vpx01.dbf' m»
SIZE 1G AUTOEXTEND ON NEXT 10M MAXSIZE
UNLIMITED LOGGING EXTENT MANAGEMENT >
LOCAL SEGMENT SPACE MANAGEMENT AUTO;

NOTE The datafile path (‘/u01/app/oracle/oradata/vcdb/
vpx01.dbf" in this case) must be a valid path on your Oracle sys-
tem; change this to match your particular environment.
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3. Open a SQL*Plus window with a user that has schema owner
rights on the vCenter Server database to create the database
schema.

4. Locate the dbschema scripts in the vCenter Server installation
package bin/dbschema directory.

5. In SQL*Plus, run the scripts in sequence on the database. <path> is
the directory path to the bin/dbschema folder.

@<path>/VCDB_oracle.SQL
@<path>/purge_statl_proc_oracle.sql
@<path>/purge_stat2_proc_oracle.sql
@<path>/purge_stat3_proc_oracle.sql
@<path>/purge_usage_stats_proc_oracle.sql
@<path>/stats_rollupl_proc_oracle.sql
@<path>/stats_rollup2_proc_oracle.sql
@<path>/stats_rollup3_proc_oracle.sql
@<path>/cleanup_events_oracle.sql
@<path>/delete_stats_proc_oracle.sql

6. All supported editions of Oracle Server require that these addi-
tional scripts be run to set up scheduled jobs on the database:

@<path>/job_schedulel_oracle.sql
@<path>/job_schedule2_oracle.sql
@<path>/job_schedule3_oracle.sql
@<path>/job_cleanup_events_oracle.sql

7. Oracle can use a local or remote Oracle instance. From the same
SQL*Plus window, run the following script (where VPXADMIN is
the user):

CREATE USER "VPXADMIN" PROFILE "DEFAULT" m

IDENTIFIED BY "oracle" DEFAULT TABLESPACE m»
"VPX" ACCOUNT UNLOCK; ==

grant connect to VPXADMIN; m=»

grant resource to VPXADMIN;

grant create view to VPXADMIN; =

grant create sequence to VPXADMIN; =
grant create table to VPXADMIN; =

grant execute on dbms_lock to VPXADMIN; =
grant execute on dbms_job to VPXADMIN; =
grant unlimited tablespace to VPXADMIN;
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If the Oracle database is not installed on the same system as vCen-
ter Server, download and install the Oracle client.

On the vCenter Server system, open the Windows ODBC Data
Source Administrator by choosing Settings > Control Panel >
Administrative Tools > Data Sources (ODBC).

NOTE If you are using a 64-bit operating system, run the 32-bit
ODBC Administrator application, which is located at C: \Windows\
SysWOW64\odbcad32.exe.

10.
1.

12.

13.

14.
15.

Select the System DSN tab and click Add.

Select the appropriate Oracle driver for your installation and click
Finish.
Enter the name of the DSN, such as vCenter Server.

Ensure that appropriate values appear in the TNS Names field ref-
erencing the local or remote Oracle instances. Select the appropri-
ate TNS Service name.

Enter the username created in the Create User section.

Click OK. An Oracle database is now available for the vCenter
Server installer.

Like SQL Server, Oracle is a popular database and is also relatively
simple to configure for use with vCenter Server.

Install vCenter Server

Now that you have configured a database, you can begin installing
vCenter Server. Remember that vCenter Server includes an installation
of Microsoft SQL Server 2005 Express Edition, and if a database has
not previously been installed, the vCenter installation will provide the
ability to set up an initial database.

Installing vCenter Server consists of these steps:

1.

Prepare for installation.

2. Install vCenter Server.

3. Install additional components.
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4. Install vSphere Client.

5. Configure vCenter.

The steps have been segmented in this way to provide a better logical
flow of how the process works. Each step is dependent on the previous
task, and all the steps are detailed in the following sections.

Prepare for Installation

Before attempting to install the vCenter Server, make sure that your
server meets the following criteria:

= The server must meet the hardware requirements (see Table 3.1).
= The server must be configured with a static IP address.

= The computer name must consist of fewer than 15 characters. To
conform with best practice, ensure that the computer name matches
the hostname in the fully qualified domain name of the system.

= The system must be joined to a domain, and not a workgroup.
This will ensure that when you’re using advanced features like the
vCenter Guided Consolidation Service, it will be able to find all
domains and systems on the network for the purpose of convert-
ing physical systems to virtual machines.

= Asupported database must already be created, unless you’re using
the bundled SQL Server 2005 Express Edition.

= A valid DSN must exist to allow vCenter Server to connect to the
created database.

= The vCenter Server must be able to directly access the hosts it will
manage without any type of network address translation between
the server and the hosts.

=  The vCenter Server must be able to communicate with the ADAM
(LDAP) server.

Install vCenter Server

To start leveraging the capabilities and enterprise-class features of
vSphere, you must install vCenter Server. The installer will guide you
through each step of the process:

1. Because VMware does not typically ship software to its cus-
tomers, to get started you must download the vCenter Server
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installation media from the VMware site (Figure 3.1). The down-

load area is located at http://www.vmware.com/download/.

NOTE To download the software, you must set up an account at
the VMware store, which you typically do upon purchase of
VMware products. vCenter Server is available in two formats: ISO
format (DVD-ROM image file) or a .zip (compressed) file.
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Either format will install all of the components necessary, but
there are differences. The .1iso file may need to be burned to a
DVD-ROM for the purpose of installing the software, while the
.zip file must be extracted to a location large enough to accom-
modate the decompressed files.

vCenter Server can be installed from a DVD-ROM, local path,
mapped drive, or network share, but the software can only be

installed to the local machine on a local drive. Select autorun.exe

to start.

On the splash screen shown in Figure 3.2, click vCenter Server to

begin.
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Figure 3.2: vCenter Serverinstaller splash screen

[« ¥™Mware vCenter Installer

vCenter Server 4.0

Choose an item to install:
WCenter Server!
vCenter Guided Consolidation Service
vSphere Client
vCenter Update Manager
vCenter Converter
Explore the media
Exit

4. On the next screen, select the appropriate language for your
installation and click OK.

5. Accept the license agreement by choosing “I agree to the terms of
the license agreement,” and then click Next.

6. On the Customer Information screen, enter your name and orga-
nization; then click Next.

7. On the next screen, enter your license key; vCenter Server will be
installed in evaluation mode if you fail to enter a key. (You can
update the licensing at a later time through vSphere Client.)
Click Next.

8. On the Database Options screen shown in Figure 3.3, select
the Use An Existing Supported Database radio button, and
from the Data Source Name (DSN) drop-down list, select the
ODBC connection you set up in the previous section “Create a
vCenter Database in Microsoft SQL Server 2005 or “Create
a vCenter Database in Oracle,” depending on the database plat-
form chosen. Select the Install A Microsoft SQL Server 2005
Express Instance option if no other supported database is avail-
able. Click Next.
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Figure 3.3: Database Options screen

i"a ¥Mware vCenter Server 5

Database Options

Select an ODBC data source for vCenter,

wCenter requires a database.

& Install a Micrasaft SQL Server 2005 Express instance (for small scale deployments):

Building a VMware
vSphere Environment

€~ Use an existing supported database

Data Source Name (DSM); | (Please create a 32 bit systam DSM) d

MOTE: There is no DSH which can be used, YMware wCenter Server requires a 32 bit
system DEN with supported types of databases and wersions of drivers.

Instaflshisld

< Back. I Mext = I Cancel

9. You’ll install the vCenter Service next, as shown in Figure 3.4.
This service is the core of vCenter Server. For our example, leave
the Use SYSTEM Account radio button deselected, and fill in the
Account Name, Account Password, and Confirm The Password
text boxes. It is considered a best practice to use a Windows
domain account, especially if the database is utilizing SQL Server
20035, as you can then use Windows authentication when connect-
ing to the database. Click Next to continue.

Figure 3.4: The vCenter Service screen

i';‘ ¥Mware vCenter Server =
vCenter Service

Enter the vCenter service account information.

Configure the wCenter service to run in the SYSTEM account or in a user-specified account
in the domain.

I Use SYSTEM Accourt

Account name: IstentEr
Account password: Iwwww
Confirm the password: Immmm

SECURITY ADWISORY: The wCenter installer grants the "Log on as a service” right to
user-specified accounts,

Installshisld
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10. On the next screen, accept the default installation path as recom-
mended, unless you wish to modify it, and then click Next.

11. A new component of vCenter Server is the ability to run Linked
Mode vCenter Servers for additional scalability. During an initial
installation, you must install the first instance for vCenter Server,
as shown in Figure 3.5. After you select the first option, click Next.

Figure 3.5: The vCenter Linked Mode Options screen

vCenter Linked Mode Options

Install this YMware vCenter Server instance in linked mode or standalone mod

To configure linked mode, install the first ¥Center instance in standalone mode. Instal
subsequent wiZenter instances in linked mode,

(+ Lreate a standal ¥Muware vCenter Server instance;

Use this option For standalone mode ar For the First wCenter installation when you are
Farming & new linked mode group.

~ Join a YMware yCenter Server group using linked mode to share
information

Use this option For the second and subsequent vCenter installations when yvou are
Forming a linked mode group,

Installshield

< Back I ext = I Cancel

vCenter Server now uses Microsoft ADAM to handle Directory
Services.

12. The Configure Ports screen appears next, as shown in Figure 3.6.
The default ports appear in the fields; you can modify these ports
to fit your environment, but for this example, accept the default
values by clicking Next.

13. Click Next on the last screen to kick off the installation.

When the vCenter Server installation is complete, vCenter will be
ready for you to configure to manage ESX and ESXi hosts. To perform
management tasks, you must install vSphere Client. Additional compo-
nents can be installed before or after the installation of vSphere Client.
To make the process flow more evenly, let’s start by installing the addi-
tional components first.
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Figure 3.6: The Configure Ports screen

i'E* ¥Mware vCenter Server .
Configure Ports

Enter the connection information for wCenter,

HTTRS port:
HITP part: o
Heartbeat port (LD IF
‘Web Services HTTP port: W
‘Web Services HTTPS part: W
LDAP Port: fes
S5L Port: 536

Installshield

< Back | Mext = I Cancel

Install Additional Components

To extend the functionality of vCenter Server, several additional com-
ponents are included. These add-ons give vCenter greater functionality
in the area of ESX and ESXi patching, as well as the ability to convert
physical, or other virtual, systems into a vSphere environment. These
add-ons include

vCenter Guided Consolidation This add-on is used to determine
whether systems are good candidates for virtualization. It works
hand in hand with vCenter Converter Enterprise to import systems
into vSphere.

vCenter Converter Enterprise This add-on is used to perform a
physical-to-virtual (P2V) conversion or a virtual-to-virtual (V2V)
conversion of systems into vSphere.

vCenter Update Manager This add-on is used to manage security
updates, or patches, for ESX and ESXi hosts, Windows guests, and
various Linux guests.

Now that you are familiar with some of the additional components,
let’s see how they are installed.
y
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Install vCenter Guided Consolidation

vCenter Guided Consolidation is a lightweight version of VMware’s
Capacity Planner service. It analyzes systems that you want to virtualize
in a vSphere environment.

vCenter Guided Consolidation cannot function without the foun-
dation of vCenter Server. Once vCenter Server is installed, you can
install vCenter Guided Consolidation, thus extending the functional-
ity of vCenter Server.

To install vCenter Guided Consolidation Manager:

1. Select vCenter Guided Consolidation Service on the splash screen,
shown in Figure 3.7.

Figure 3.7: VMware vCenterinstaller splash screen

% yMware vCenter Installer = L

vCenter Server 4.0

vCenter Guided Consolidation Service
vSphere Client

vCenter Update Manager

vCenter Converter

Explore the media

Exit

2. On the next screen, select the appropriate language setting and
click Next.

3. On the next screen, accept the license agreement by choosing “I
agree to the terms of the license agreement,” and then click Next.

4. On the next screen, accept the default installation path, unless you
wish to modify it, and then click Next.

5. The VMware vCenter Collector Service screen shown in Figure 3.8
opens. This service requires an account that will have local adminis-
trator rights on the systems it is evaluating for possible P2V conver-
sion. The account may be a domain account, but Microsoft doesn’t
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recommend that you use a domain admin account. Enter an account
and password with local administrator rights, and then click Next.

Figure 3.8: The VMware vCenter Collector Service screen

i ¥Mware vCenter Guided Consolidation - InstallShield Wi

¥Mware vCenter Collector Service

Enter the service account credentials for the wCenter Collector Service:

Building a VMware
vSphere Environment

The vCenter Collector Service component discovers computers in your netwark and collects
performance data, This service must run in the context of & user account that is a lacal
administrator on this machine. This account can be a domain user account specified as

DomainklamelUserfame.
User name: I
Password: |
Confirm Passward: |
Note:

Setup will install twa self-signed certificates as trusted root certificates in the Windows Certificate
Stare, You can replace these certificates later with your own certificates by referring to the
YWMware vSphere dacumentation,

Install5hisld

< Back Cancel

6. On the next screen (Figure 3.9), review the port information.
The Guided Consolidation Service requires two additional TCP/
IP ports for the Collector Service and the Provider Service. These
ports are set to 8181 and 8182 by default. Click Next.

Figure 3.9: Reviewing the portinformation

i ¥Mware vCenter Guided Consolidation - InstallShield Wi

¥Mware vCenter Collector Service

Review the port information For YMware vCenter Guided Consolidation

Review the ports that will be used by the Collectar Service, Provider Service and the wCenter Web
Server, Ports entered should be in the range 1-65535, The default ports that will be used by
these services have been set.

Whware vCenter Collector Service Port: W
Whware vCenter Collector Provider Service Pork: IW
wCenter Web Server HTTF port: ISDSD—
wCenter Web Server HTTPS port: lr

wCenter Web Server is already found to be installed and running on this machine, The
same instance will be used For YMware vCenter Guided Consolidation,

Tnistal5hisld

< Back Cancel

7. On the VMware vCenter Server Registration screen shown in
Figure 3.10, enter the name or IP address of the vCenter Server,
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along with the SSL port number (443 by default). Then enter the
credentials required to register the extension with vCenter Server.
The credentials you use must have the extension registration privi-
lege. Click Next once you’ve entered this information.

Figure 3.10: The VMware vCenter Server Registration screen

{& ¥Mware vCenter Guided Consolidation - InstallShield Wi_z_ai‘ﬂ._- i

¥Mware yCenter Server Registration

Enter the wCenter Server information

WMware vCenter Guided Consolidation is an extension to the vCenter Server. Enter the
connection details of the vCenter server to which this installation will act a5 an extension,

IP Address | FQDM of wCenter i
G Ivcenter.]asem:carty.:om
Secure Port: 443

Enter the credentials of the user account that has extension registration privileges on the
WiZEnter Server,

User name: |Adm|n|strator

Password: Iw*w*w

Confirm Password: IMW*M*
Installshisld
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8. On the Server Identity screen shown in Figure 3.11, specify either
the FQDN or the IP address of your vCenter Server and click Next.

Figure 3.11: The Server Identity screen

i‘_{l ¥Mware vCenter Guided Consolidation - InstallShield Wiz

Server Identity

Specify how this machine is identified aver the network,

wveenter. jasemccarky .com i

InstallShisld

< Back. Cancel

9. Click Install on the next screen to begin the Guided Consolidation
Service.
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The vCenter Guided Consolidation Service will now be available to
you through vSphere Client; just select the Consolidation tab.

Install vCenter Converter Enterprise

vCenter Converter Enterprise is the natural progression from vCenter
Guided Consolidation. The information vCenter Consolidation gath-

ers is only useful if it can be acted upon—in other words, if you want

to convert a physical system into a virtual system. vCenter Converter
Enterprise handles the task of converting a physical system that has been
determined to be a good virtualization candidate into the vSphere world.

To add the ability to perform P2V conversions from within vCenter

Server:

1. Select vCenter Converter from the splash screen shown earlier in
Figure 3.7.

2. Select the appropriate language setting on the next screen and
click Next.

3. Choose “Iagree to the terms of the license agreement” on the next
screen and click Next.

s

Accept the default installation path, unless you wish to modify it,
and click Next.

5. On the Setup Type screen, shown in Figure 3.12, click the Custom
radio button. This way, you can control which components are
installed.

Figure 3.12: The Setup Type screen

Setup Type
Click the type of setup vou prefer, then click Next,

" Typical {Recommended)

@ The most common companents wil be installed,

& Custom!

Choose the individual companents you want installed,

Irstallshield

< Back I Mext > I Cancel
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6. The screen shown in Figure 3.13 appears. Note that Converter

Agent is only required if the server that vCenter Converter is
installed on is going to be converted. Click Next.

Figure 3.13: Custom Setup screen

|.';3 ¥Mware vCenter Converter 3

Custom Setup

Seleck the components you wank ko install,

Click. on an ican in the lisk below ko change how a component is installed,

= - |

= b " Enables the import and export of
OnYerer warious machines through a %I

X_-| Converter Agent Client or the Converter CLT,

Description

This Feature requires 76MB on
your hard drive.

InstallShield
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7. On the next screen, shown in Figure 3.14, enter the IP address

and port of the vCenter Server, along with a user account that
has appropriate permissions in vCenter Server and the password
associated with it. This will ensure that Converter Enterprise can
effectively integrate with vCenter Server.

Figure 3.14: The Specify The vCenter Server To Connect To screen

if_\g ¥Mware vCenter Converter 3 ZI

wCenter Server r’
Specify the vCenter Server to connect to. __JJ

Enter the wiZenter Server ta connect to and the login information below:

Server: Port:

[t92.1¢8.1.150 i3

User Mame: Password:

|JASEMCCARTV\stenter |*****»=**
Installshisld
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8. Select the default ports on the next screen (Figure 3.15) by click-
ing Next.

Figure 3.15: The vCenter Server Port Configuration screen

i YMware vCenter Converter
yCenter Server Port Configuration

Specify the YMware Yirtual Infrastructure Web Service Ports,

HTTPS Part: W
|au

HITP Paortt

SOAP Pork: Igggs
‘e Port: |9086

Install5hisld
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9. On the screen shown in Figure 3.16, specify the vCenter Server

identity to verify which vCenter Server instance will be used.
Click Next.

Figure 3.16: vCenter Server Identification

{i ¥Mware yCenter Converter I x|
¥Mware vCenter Server rr,—
How do you want ko identify this machines jJ

Specify how this YMware wCenter Server should be identified on the netwark,

Install5hield
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10. Click Install to begin the installation.

11. On the final screen, click Finish to complete the installation.
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With vCenter Converter Enterprise installed, growing the vSphere
environment can be accomplished quickly and easily.

Install vCenter Update Manager

As the vSphere environment grows, additional ESX and ESXi servers
may be added. As the numbers of hosts grow, maintenance, and specifi-
cally patching, can become a burden. In the days of ESX 2.x, patches
had to be copied to hosts, hosts had to be rebooted into a Linux single-
user mode, and then patches were installed. The majority of times,
it was easier to simply rebuild hosts using some type of automated
scripting.

This manual patching process required VMware administrators
to have some Linux command-line knowledge or at least familiarity.
VMware released VMware Update Manager with the launch of Virtual
Infrastructure 3 with the aim of making the patching process signifi-
cantly easier. vCenter Update Manger also has the ability to patch
Windows and Linux guests in a similar fashion to ESX and ESXi hosts.
It is a complete solution for the patching of VMware hosts, Windows
guests, and Linux guests. In vSphere, this product has been rebranded
as vCenter Update Manager.

To take advantage of the abilities of vCenter Update Manager:

1. Select vCenter Update Manager from the splash screen shown ear-
lier in Figure 3.7.

2. On the next screen, select the appropriate language setting and
click Next.

3. On the next screen, click “T agree to the terms of the license agree-
ment” and click Next.

4. On the next screen, shown in Figure 3.17, enter the IP address and
port of the vCenter Server installation, followed by a username
and password so that vCenter Update Manager can properly com-
municate with vCenter Server. Click Next.

5. On the next screen (see Figure 3.18), select the database to be used
for the vCenter Update Manager. If the default SQL Server 2005
Express database was installed during the vCenter Server installa-
tion, select Install A Microsoft SQL Server 2005 Instance; other-
wise select Use An Existing Supported Database radio button, and
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select the preconfigured DSN from the Data Source Name (DSN)

drop-down menu.

Figure 3.17: Entering the vCenter Server information

i%"‘ ¥Mware vCenter Update Manager

wienter Server Information

Enter vCenter Server IP address and credentials

Please provide the necessary information about vCenter Server below, ¥Mware vCenter
Update Manager will need this information to connect ko the wCenter Server at startup,

WMwate vCenter Server Information

Lk [192.165.1.150 HTTRPort: fap

Username: IJASEMCCARTYlstental Password: [t

Installshield
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Figure 3.18: Specifying a database

h% ¥Mware ¥Center Update Manager . 5[
Database Options rF
Select an ODBC data source For Update Manager.

Update Manager requires a database,

" Install a Microsoft SGL Server 2005 Express instance ifor small scale deployments)

" Use an existing supported database

Data Source MName (DSN):

are \firtualCenter

Installshield
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6. Asyou can see on the next screen (Figure 3.19), vCenter Update
Manager requires authentication. If the DSN created uses NT
Authentication, then a username and password is not required. If
the database uses database authentication, then enter a username

and password and then click Next.
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Figure 3.19: You canleave these fields blank ifthe DSN uses NT Authentication.

i"‘!:" ¥Mware vCenter Update Manager )

Datahase Information

(7

Enter additional database configuration information.

DSN: ¥Mware VirtualCenter

ODBC Driver: C\WINDDWS', system32  sqlnchi.dil

Database username and password fields can be left blank if the DSM is using Windows
NT authentication.

Database Username: ||

Database Password: I

Install5field
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7. On the next screen (see Figure 3.20), enter the required connec-
tion information, which tells vCenter Server, ESX, and ESXi hosts
how to talk to vCenter Update Manager. Then click Next.

Figure 3.20: Entering the required connection information

il\g‘ ¥Mware vCenter Update Manager )

WMware wCenter Update Manager Part Settings

Enter the connection information for Update Manager

Specify how this ¥iware wCenter Update Manager should be identified on the network, Please
make sure this IP address or host name can be accessed from both vCenter Server and hosts,

Setup will open the ports in firewall if the Wwindows FirewallfInkernet Connection Sharing
seryice is running on the system.

SOAF Port: ‘wieh Port: 551 Port:
I8084 i 9087

I es, I have Internet connection and I want to configure proxy sethings now,

Installshield
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8. On the screen shown in Figure 3.21, if the vCenter Update
Manager service is behind a proxy server, select Configure Proxy
Settings and enter the required information. Otherwise, click
Authenticate Proxy Using The Credentials Below and complete
those fields. Once you’ve entered the information, click Next.
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iifa ¥Mware vCenter Update Manager

Proxy Settings

Enter the connection information far the Proxy,

—Iv Configure Proxy Settings

()

x|

Provide the necessary information required in order to validate vour proxy settings.,

Proxy Server: |proxy.iasemccarty.com

a0a0]

I~ futhenticate proxy using the credentials belaw

Proxy Port:

User name: I

Password: I
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This information will give vCenter Update Manager the ability
to access and download patches when connected to the Internet

behind a proxy server.

9. Use the default installation paths and click Next.

10. Click Install to start the installation.

11. Click Finish to complete the installation.

Now that the additional components for vCenter Server have been
installed, the installation of vSphere Client will provide you with the
ability to manage vCenter Server and the additional components.

Install vSphere Client

vSphere Client is the next iteration of the VI Client. When the VI
Client was introduced with the 1.0 version of VMware Virtual Center,
it lacked the ability to directly manage the vast majority of settings in
ESX 2.x hosts. When version 2.0 was introduced to manage ESX 3.0,
and later ESXi, the VI Client was given the ability to manage either
vCenter Server or ESX and ESXi hosts directly. The release of the 2.5
version of the Client, which was coupled with the release of vCenter
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Server 2.5, added the ability to use custom plug-ins for the purpose of
better integrating all the features and offerings into a single interface.

vSphere Client is similar to the VI Client, version 2.5, in operation.
Here’s how to get started using it:

1. Select vSphere Client from the splash screen shown earlier in
Figure 3.7.

2. Select the appropriate language setting and click Next.

3. On the next screen, click “T agree to the terms of the license agree-
ment” and click Next.

4. Enter the appropriate customer information on the next screen
and click Next.

5. vSphere Client will present an option to install the vSphere Host
Update Utility 4.0. This utility allows administrators to patch, or
update, ESX and ESXi hosts without using the vCenter Update
Manager. This is an optional component that extends the ability
to upgrade ESX and ESXi hosts without using Update Manager.

6. On the next screen, choose the default installation path, unless
you wish to modify it, and click Next.

7. Click Install to start the installation.
Microsoft Visual J# 2.0 Second Edition is installed as a required

component of vSphere Client.

8. On the final screen, click Finish to complete the installation.

vSphere Client is installed. Plug-ins for additional components that were
installed will have to be added upon connecting to vCenter Server.

Now that vSphere Client is installed, the initial setup of the vSphere
environment can begin. vSphere Client is the administrator’s window
into the vSphere world.

Configure vCenter

Configuring vCenter includes these steps:
= Connecting to vCenter

= Installing plug-ins in vSphere Client
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Configuring Advanced Settings
Creating a datacenter

Creating clusters
Adding hosts

Each of these steps must be accomplished to leverage the complete
feature set of vSphere. For example, enterprise features such as VMware
High Availability and Distributed Resource Scheduling cannot be used
unless you’ve configured a cluster.

Connect to vCenter Server

As you know, vCenter Server operates as a Windows service on the
vCenter Server system. There is no native interface in Windows to access
the vCenter installation. This function is achieved via vSphere Client.

To connect to vCenter Server:

1.
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Launch the VMware vSphere Client by choosing Start >
Programs > VMware > VMware vSphere Client, or double-click
the VMware vSphere Client on the Desktop.

When vSphere Client login dialog box (see Figure 3.22) opens,
enter the IP address or hostname of the vCenter Server, along
with a valid username and password. Alternatively, select the Use
Windows Session Credentials check box to use the context of the
current user account logged into the system.

Figure 3.22: vSphere Clientlogin dialog box

Mware ¥Sphere Client

vSphere Client

To directly manage a single host, enter the IP address or host name.
To manage multiple hosts, enter the IP address or name of a
wiCenter Server.

IP address | Mame: Ivcenter‘]asemcmrty.mm j

User name: ||

Password: I

" Lse Windows session credentials

Login I Close Help
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3. A Security Warning dialog box (see Figure 3.23) appears. This
box simply states that you have not chosen to trust the cer-
tificate that the vCenter Server is configured to use. Select the
option Install This Certificate And Do Not Display Any Security
Warnings for “IP/hostname”. Then click Ignore to continue.

Figure 3.23: Security warning

—Certificate Warnings -

An untrusted SSL certificate is installed on "192, 168, 1. 150" and secure communication cannot be

| guaranteed. Depending on your security policy, this issue might not represent a security concern,
You may need to install a trusted SSL certificate on your server to prevent this warning from
appearing.
The certificate received from "192, 168. 1. 150" was issued for "WMware default certificate”. Secure
communication with "192. 168. 1. 150" cannot be guaranteed. Ensure that the fully-qualified

| domain name on the certificate matches the address of the server you are trying to connect to.
|

I Click Ignore to continue using the current S5L certificate.

View Certificate Ignore Cancel

¥ 1Install this certificate and do not display any security warnings for "192.168.1.150",

When vSphere Client loads, if you have not configured licensing
for your environment, you will be presented with an Evaluation
Notice, warning you about the evaluation period, and what will
occur if you do not install your licenses. Click OK.

Once you’re connected to vCenter Server, configuration can begin.

order for you to leverage the additional capabilities.

Install Plug-ins in vSphere Client

Plug-ins extend the abilities of vSphere Client. VMware-provided plug-
ins are installed through the Plug-ins drop-down menu in vSphere

Client interface.

Not all of the previously installed additional components require
a plug-in, but the vCenter Converter Enterprise and vCenter Update

Even though vSphere Client is installed, if any additional components
have been installed, their associated plug-ins will have to be loaded in

Manager components do to have a plug-in associated with them. Here’s
how to install them:
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1. In vSphere Client, select Plug-ins > Plug-in Management, as

shown in Figure 3.24.
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Figure 3.24: Select Manage Plug-ins from the Plug-ins menu.

(53] YCENTER - vSphere Client

Eile Edt View Inventory Administration |Plug-ins | Help

O 8 [0 e b s ol i
(i

) VCENTER

& [ [DATACENTER.
[ 03 jpmemccarty.cor
[@ esvioh josemccorty.cor

‘ W Search Invertory a

€) Add avirtual machine Conplee setup

ou have selected the datacenter

The next step is adding a virtual machine to the host. To
continue setfing up vCenter, select the host

4= Selectyour newly added host @
in the inventory o the left

| i E— | =
Recent Tasks x
Name. | Target | Status | Details | Initiated by | vCenker Server | = Requested Start Time | Start Time | Complete

| >

Evaluation Mode: 32 days remairing | Administratar

FB% ) ma

rémks @ Alams \
#istart| |3 &

| [ veenTER - vephere ...

The Plug-in Manager shown in Figure 3.25 appears. The installed
plug-ins are listed, and there are two additional plug-ins available
for download and installation. These additional plug-ins are for
vCenter Converter Enterprise and vCenter Update Manager.

Figure 3.25: Plug-in Manager

(4 Plug-in Manager [_[O[x]
Plug-in Name | Vendor | Version | Status | Description | Progress | Errars |
Installed Plug-ins
& consolidation 4.0 Enablsd consolidation
& wSphere Client Storage ware, Inc. 1.0.00  Enabled wCenter Storage Information
& Hardwars Status VMware, Inc. 1.0.00 Enabled Hardware Status
& wCenter Service Status. Uware, Inc 1.0.00  Enabled wCenter Service Status
Available Plug-ins
& wCenter Converter Uhware, Inc 4.1.0 Download and T wCenter Converter
& WMnare vCenter Update Mana...  Wnare, Inc, 4.0.0... Downloadand .., YMware vCenter Update Manager

extension

Help

Close .

Click Download And Install next to vCenter Converter in the
Status column, as shown in Figure 3.26.
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Figure 3.26: Installing the vCenter Converter plug-in

#IPlug-in Manager =
Plug-in Name | wendar | version | Status | Description | Progress | Errars |
Installed Plug-ins
& consolidation 4.0 Enabled consolidation
& vphere Client Storage: YMuware, Inc, 1.0.00  Enabled wCenter Storage Information
& Hardware Status VHware, Inc, 1,000 Enabled Hardware Status
& wiCenter Service Status YMware, Ine. 1.0.00  Enabled vCenter Service Status
Available Plug-ins
(% [Wenter Converter YMware, Inc. 4.1.0  Downloading... wCenter Converter P —

& WMwars vCenter Update Mana...  YMware, Inc. 4,00, Download and L.,  ¥Mware vCentsr Update Manager
extension
Help Close
A

This will download the installation and launch the installation
process.

Choose the appropriate language and click OK. Then click Next.
On the next screen, click Install.

Click Finish to complete the plug-in installation.

© ok w

Click Download And Install in the Status column next to vCenter
Update Manager. Again, this will download the installation and
launch the installation process.

7. Choose the appropriate language, then click OK and Next; select
the license agreement and click Next; and then click Install.

Click Finish to complete the installation.
9. When you see the security dialog box, click Ignore.
10. Click Close to close the Plug-in Manager.

Now that all of the plug-ins have been installed, you will be able to
use the additional components.

Configure Advanced vCenter Server Settings

The basic installation of vCenter Server is complete. You can configure
some additional settings to add to the overall usefulness of the installation.

These advanced settings affect the way vCenter Server behaves under
normal operation. Some of these settings can be configured once, and
others may need to be modified depending on how the environment is
managed.
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To configure vCenter Server settings, first select Administration >

License Settings These settings are used to manage licenses for
vCenter Server, ESX, and ESXi hosts, as well as legacy ESX and
ESXi hosts. This topic will be discussed in more detail in Chapter 4.

Statistics These settings are used to modify the view or the sta-
tistics parameters for data collection, and provide database sizing
estimations.

Building a VMware
vSphere Environment

Runtime Settings The Runtime settings—Unique ID, Managed IP,
Name Used—distinguish this vCenter Server installation from another
installation when you’re using vCenter Server in Linked Mode.

Active Directory These settings are used to set up AD timeout,
query limit, validation, and validation timeout. The settings are
especially important when vCenter Server is part of a large domain
environment.

Mail These settings are used to configure a Simple Mail Transfer
Protocol (SMTP) server for the purpose of sending out email alerts
when alarms are triggered by issues occurring in clusters, hosts,
guests, and the like.

SNMP Use these settings to configure Simple Network Management
Protocol (SNMP) to send data to external monitoring services, or to
allow for the querying of information from vCenter Server by external
monitoring services.

Web Service Use these settings to configure the web service ports
for vCenter Server. The defaults are 80 and 443, and you should
change them only if there are conflicts with other services operating
on the same ports on vCenter Server.

Timeout Settings These settings are used to manage the amount
of time vSphere clients should wait for a response for long and short
operations. The settings can be used to tweak the timeouts when
you’re using vSphere Client over low-bandwidth networks.

Logging Options These settings are used to modify the logging
level for vCenter Server log files. You can change the level of logging
to enhance troubleshooting when there are issues in the vSphere
environment.

Database The total number of connections to the database is con-
figured here. This setting can be changed to increase or decrease
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the number of connections, which can increase or decrease the per-
formance of vCenter Server.

Database Retention Policy As events occur in the vSphere environ-
ment, they are logged in the vCenter Server database. Collection

of these events over time can increase the size of the database. The
retention policy will allow you to purge events that are older than
the number of days you configure here.

SSL Settings These settings are used to view and require SSL cer-
tificate checking between ESX and ESXi hosts when you’re adding
them to vCenter Server, as well as when you’re using vSphere Client
to connect to the console of guests.

Not all of the advanced features will have to be modified, but some
will need to be changed to enable communication with the environment
in which vSphere will be operating.

Create a Datacenter

To begin configuring the virtual environment, you need a datacenter.
A datacenter is the logical container of clusters, ESX and ESXi hosts,
resource pools, and virtual machines. Multiple datacenters are typically
created when a vCenter Server instance is managing hosts and guests in
multiple locations, but this is not a required configuration.

Create a datacenter using one of the following methods:

= Selecting File > New > Datacenter
= Pressing Ctrl+D

= Right-clicking on the vCenter Server name in the left panel
and choosing New Datacenter from the initial logon screen.

= Clicking Create A Datacenter on the Getting Started tab in
the right panel, as shown in Figure 3.27

The datacenter will be named New Datacenter, and the name will be
highlighted, allowing you to rename the datacenter to a name appro-
priate for your environment or to coordinate with your environment’s
naming standards.

Figure 3.27: Click Create A Datacenter.

To get started, click Create a datacenter.
ﬂ Create a datacenter
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the new name, and then press Enter.

Add a Cluster

Clusters are not actually a requirement in the vSphere environment, but

they do provide for additional capabilities in vSphere. Without a clus-

ter, additional features such as High Availability (HA) and Dynamic
Resource Scheduling (DRS) across ESX and ESXi hosts would be

unavailable.

To leverage these features, let’s configure a datacenter:

1. After selecting the datacenter object, add a cluster by using one of

the following methods:

= Select File > New > Add Cluster.

= Press Ctrl+L.

= Right-click on the datacenter you created, and select New

Cluster.

2. When the New Cluster Wizard open, as shown in Figure 3.28,
enter a name for the cluster in the Name text box.

Figure 3.28: Enter aname on the first screen of the New Cluster Wizard.

[ New Cluster Wizard

Cluster Features

JH[=] B3

what Features do wou want to enable For this cluster?

Cluster Features
WMiware DRS
Pawer Management
WMiware HA
Yirtual Machine Gptions
4k Manitoring
WIMware EVC
VI Swapfile Location
Ready to Complete

—Hame:

JeLusTer

i~ Cluster Features

Select the Features you would like to use with this cluster,

¥ Turn on YMware HA

WMware Ha detects Failures and provides rapid recovery For the virtual machines
running within & custer, Core functionality includes host monitoring and wirtual
machine maonitoring ko minimize dovntime when heartbeats are lost,

IV {fin On Viwiare DRSE

Whiware DRS enables vCenter Server ko manage hosts as an aggregate pool of
resources. Cluster resources can be divided inko smaller resource pools for users, groups,
and virtual machines.

YMware DRS also enables wCenter ko manage the assignment of virtual machines to hosts
automatically, suggesting placement when virtual machines are powered on, and
migrating running wirtual machines to balance load and enforce resource sllocation
palicies.

Help

= Back I Mext = I Cancel
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3. Ascluster features are selected, the list of steps in the left panel
will add additional components for configuration.

4. To enable VMware High Availability features, select the Turn On
VMware HA check box.

5. To enable VMware Distributed Resource Scheduling, select the
Turn On VMware DRS check box.

6. Click Next to continue.

We’ll continue these steps in the next section.

Configure VMware DRS

VMware DRS options are shown in Figure 3.29. Follow these steps:

Figure 3.29: VMware DRS

(%) New Cluster Wizard 2 =1oix]

¥Mware DRS
What level of automation do you want this custer to use?

Cluster Features
YMware DRS

—Aukomation lewel

Pawer Management " Manual
hare HA wCenter will suggest migration recommendations For virtual machines.

WVirbual Machine Options

VM Monitoring " Partially automated
WMware EVC Wirtual machines wil be automatically placed onto hosts at power on and vZenter will
1 SwapFile Location suggest migration recommendations For virtual machines.

Ready ko Complete

o'

Fully automated

Wirtusl machines wil be automatically placed onto hosts when powered an, and will be
automatically migrated to attain best use of resources,

Migration threshold:  Conservative —J— Aggressive

Apply priority 3 ar higher recommendations
wCenter will apply recommendations that promise at least good improvement ko the
cluster's lnad balance.

Help = Back Mext = |

1. Ifyou selected Turn On VMware DRS in step 5 in the previous
section, you’ll see the What Level Of Automation Do You Want
This Cluster To Use? screen. The DRS feature allows vCenter to
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load-balance guests across hosts to make sure that there is an even
load across all hosts. Select one of the available radio buttons on
this screen, depending on the configuration desired:

Manual: Choose this option to have vCenter suggest when guests
need to be migrated between hosts, as well as automatically plac-
ing guests on hosts when they are powered on.

Building a VMware
vSphere Environment

Automatic: Choose this option to allow vCenter to automatically
migrate guests between hosts in the cluster for the best use of
available resources.

Migration Threshold: Use the mouse to slide the pointer either
left or right, depending on whether vCenter should use aggressive
or conservative decisioning for the movement of guests between
hosts in the cluster.

2. Click Next after you make your choice.

3. The Power Management screen (Figure 3.30) is next. Power
Management allows vCenter to power hosts on or off as required
for a cluster’s workload. Select one of the available radio buttons,
depending on the configuration desired:

Manual: Choose this option for vCenter to recommend which
hosts should have guests evacuated and powered off, as well as
powering the hosts back when the workload suggests powering
the hosts on.

Automatic: Choose this option to have vCenter automatically
evacuate guests from one or more hosts, and power the host off
when the workload does not require the hosts. This will also auto-
matically power hosts on when the workload requires additional
host resources.

DPM Threshold: Use the mouse to slide the pointer either left or
right, depending on whether vCenter should use aggressive or con-
servative decisioning for the powering on or off of hosts depend-
ing on workload.

4. Click Next to continue.
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Figure 3.30: Power Management

lew Cluster Wizard

1o x|

Power Management
Do wou want to enable power management For this cluster?

Cluster Features — Power Management
WMware DRS
Power Management

DPM uses Wake-on-LAN, IPMI, or iLO to power on hosts. When using IPII or iLO, configure
IPMI or iLO separately for each participating host priar o enabling DPM, For all power on

Whware HA methods, test exit standby For each participating host prior to enabling DPM.

Wirkual Machine Options

WM Monitaring Specify the default power management For this cluster,
WMware EVC = iif
WM Swapfile Location wCenter will not provide power management recommendations.
Ready to Complete Individual host overrides may be set, but will not become active until

the cluster default is either Manual or Automatic,
" Manual

wCenter will recommend evacuating a host's wirtual machines and powering
off the host when the cluster's resaurce usage is low, and powering the
hast back on when necessary,

" Automatic

wCenter will automatically sxecute power management related
recommendations.

DPM Threshold:  Conservative _I Agaressive
R

Apply priority 3 or higher recommendations

Center wil apply power on recommendations produced to mest
YMware HA requirements or user-specified caparity requirements,
Power on recommendations will also be applied iF host resource

Help | = Back I Next = I Cancel |

We’ll continue these steps in the next section.

Configure VMware HA

VMware HA options are shown in Figure 3.31.

The High Availability feature lets ESX and ESXi hosts restart virtual
machines when the failure of an ESX or ESXi host occurs. The guests
will be restarted on other hosts in the cluster.

To continue with the wizard:

1. If you selected Turn On VMware DRS in step S in the section
“Add a Cluster” earlier in this chapter, you’ll see the admission
control options. Select one of the available radio buttons, depend-
ing on the configuration desired:

Host Monitoring Status: Select this check box to have vCenter
monitor hosts through heartbeats. This option can be deselected
during maintenance schedules to prevent host isolation issues,
resulting in unnecessary HA failovers.
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Figure 3.31: VMware HA

(%] New Cluster Wizard E =1oix]

¥Mware HA
What admission control do you want ko be enforced on this cluster?

(Cluster Features —Host Monitoring Status
WrMware DRS ES# hosts in this clusker exchange network heartbeats, Disable this feature when performing
¥YMware HA netwark mainkenance that may cause isolation responses,

Yirtual Machine Options
M Monitoring

YMware EVC - Admission Contral

i1 Swapfile Location Adrission contral is & policy used by Yware HA to ensure Failover capacity within a cluster,
Ready to Complete Raising the number of potential host Failures will increase the availability constraints and
capacity reserved,

Iv {Enable Host Fianitaring

% Brevent WMs From being powered on if they violate availability constraints

 Allow ¥Ms to be powered an even iF they violate availability constraints

—Admission Control Policy

Specify the type of palicy that admission control shauld enfarce.

@ Host failures cluster tolerates; T 3

¢~ Percentage of cluster resources = o
reserved as Fallover spare capacity: £ i

¥ Spedfya Falover host: &

Help < Back I Mext = I Cancel |

Admission Control: Select one of the two radio buttons to allow
(or prevent) guests to be powered on even if they violate the avail-
able resources. If you click the Prevent option, guests will not be
powered on if they require more resources than are available.

Admission Control Policy: Select one of the available radio but-
tons to choose the number of allowed host failures that can occur,
the percentage of cluster resources that should be reserved for HA,
or to specify a specific host to fail over to.

Click Next to continue.

Next you’ll see the Virtual Machine Options screen (Figure 3.32):

VM Restart Priority: This option determines the default order in
which guests are restarted. A higher value will attempt to start
more guests simultaneously.

Host Isolation Response: This option determines what a host should
do with guests if it loses connectivity with vCenter and/or the default
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gateway. The default is Shut Down. This selection ensures that

if the host can access the shared storage, guests are cleanly shut
down and the virtual disk file locks are released before another
host attempts to power them on as a result of an HA error condi-
tion. This is especially important when using iSCSI or NFS-based
shared storage.

Figure 3.32: Virtual Machine Options

e

¥irtual Machine Options
Wwhat restart options do vou want to set for WMs in this cluster?

Cluster Festures

Set options that define the behavior of virtual machines For YMware HA,
Mysare DRS

Ylware Hi Cluster Default Settings
YE ol hme etions WM restark priorty: =
Y Manitoring
Mwiare EVC Host Isolation response: IShut down -
WM Swapfile Location

Reay to Complste

Help | = Back I Mext = I Cancel |

4

4. Click Next to continue.

The VM Monitoring options (Figure 3.33) appear next. Select the
Enable VM Monitoring check box if you want to restart guests
when VMware tools heartbeats are not received in a given amount
of time. Use the mouse to slide the Monitoring Sensitivity pointer
to the left or right to change the time threshold for monitoring the
VMware tools in each guest.
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Figure 3.33: VM Monitoring options

[ New Cluster Wizard =loix|

¥M™ Monitoring

‘What monitoring do you want ko set on virtual machines in this cluster?

Cluster Features
VMware DRS
WMware HA
Yirtual Machine Options
¥M Monitoring
WMwaEre EYC
W Swwapfile Location
Ready ko Completes

Y™ Monitoring Status

WM Manitaring testarts individual YMs if their YMware tools heartbeats are not recelved within
a set time,

I iEn:

oniEoring

—Default Cluster Settings

Moritoring sensitivity:  Low —J High

HA will restart the WM if the heartbeat between the host and the M has not
been received within a 30 second interval. HA restarts the WM after sach of
the First 3 Failures every hour,

Help

= Back I Mest = I Cancel I

4

6. Click Next to continue.

7. The next screen (Figure 3.34) asks if you want to enable Enhanced
VMotion Compatibility (EVC) for this cluster. This feature allows
you to maximize VMotion compatibility and ensures that only
hosts that are compatible with those in your cluster can be added
to the cluster. EVC will only present the CPU instruction set of the
least capable processors to each guest. Select the appropriate radio

button:

Disable EVC: Select this option to disable EVC.

NOTE When you select either of the Enable options, a drop-
down box is provided so you can select the type of hosts being
used. Your selection will determine which processor instruction
sets are required for a host to become part of the cluster.
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Enable EVC For AMD Hosts: Select this option to enable EVC for
supported AMD hosts.

Enable EVC For Intel Hosts: Select this option to enable EVC for
supported Intel hosts.

Figure 3.34: VMware EVC options

(%5 New Cluster Wizard =10] x|
¥Mware EWC
Do you want ko enable Enhanced ¥Motion Compatibility For this cluster?
Cluster Features
Enhanced ¥Motion Compatibiity (EVC) configures a custer and its hosts to maximize YMation
Miare DRS compatibility, Once enabled, EVC will also ensure that only hosts that are compatible with those in
iMware HA the cluster may be added to the cluster,
YMuware EYC
M Swwapfile Location
Ready ko Complete {& pisable EVC " Enable EVC For AMD Hosts " Enable EVC For Inteh® Hosts
YMware EVC Mode;  [isablec =1
Description |
Help: < Back I Mext = I Cancel I
4

8. Click Next to continue.

9. The Swapfile Location configuration options (Figure 3.35) are
next. Here you specify whether a guest’s swap file is stored with
the guest on shared storage or on a dedicated datastore. Microsoft
recommends that you keep the swap file in the same location as
the guest. Choose the desired option and click Next.

10. When you see the Ready To Complete screen (Figure 3.36), make
sure the configuration settings are correct and click Finish.
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Figure 3.35: The Virtual Machine Swapfile Location screen

¥irtual Machine Swapfile Location

‘which swapfile location policy should virtual machines use while in this cluster?

New Cluster Wizard

=1olx|

Cluster Features
UMware DRS

Viware HA

ViMuware EVC

¥M Swapfile Location
Ready ko Complete

— Swapfile Policy For Yirtual Machines

= [Sore the swaptile in Ehe same difectory a5 Ehe Yirtual Maching (Fecommended) :

" Store the swapfile in the datastore specified by the host
I not possible, store the swapfile in the same directory as the virtual machine,

A host spes

ied datastore may degrade ¥Motion performance for the
affected virtual machines.

I Mext = I

« Back Cancel |

Ready to Complete
Review the options you have selected for this cluster and click Finish to complete.

=lol x|

Cluster Features
ViMware DRS

Viware HA

VMware EVC

Wl Swapfile Location
Ready to Complete

The cluster will be created with the Following aptions:

Cluster Name;

WMware DRS:

Whware DRS Automation Level:
WMware DRS Migration Threshald:
WMware HA Host Monitoring:
Admission Control:

Admissian Contral Policy:

Host Failures Allowed:

WM Restart Priority:
Host Isalation Response:

WMware HA %M Monitoring:
Mornitoring Sensitivity:

WhMware EVC Mode:

virtual Machine Swapfile Location:

CLUSTER

Enablad

Fully Automated

Apply priority 3 or higher recommendations
Running

Enabled
Mumber of host Failures cluster tolerates

Medium
Shut down

Suspended
High

Disabled

Same directory as the virkual machine

= Back Einish
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Add a Host

While vCenter Server is the central management point of vSphere, ESX
and ESXi hosts are the workers of the environment. To use hosts in

a managed vSphere environment, you must add them to the vCenter
Server installation. Add a host using one of the following methods:

Chapter3 » Installing and Configuring vCenter Server

= Select File > New > Add Host.

= Press Ctrl+H.

= Right-click on the datacenter you created, and select Add

Host.

= Click Add A Host on the Getting Started tab in the right panel
when a given datacenter is selected.

Once you complete one of these steps, the Add Host Wizard opens:

1. On the Specify Connection Settings screen, enter either the IP

address or the hostname of the ESX or ESXi host you want to add,
as shown in Figure 3.37.

Figure 3.37: The Specify Connection Settings screen

[4] Add Host Wizard

Specify Connection Settings

~lojx|

Type in the information used ko connect to this hast,

Connection Settings
Host Summary

Wirtual Machine Location
Ready to Complete

— Connection

Erter the name o IP address of the host to add to wiCenter.

Hast: esx40a,jasemccarty .com

[ Authorization

Enter the administrative account information for the host, v¥Sphere Client will
use this infarmation to connect to the host and establish a permanent
account For its operations.,

Username;

raat
[rm—

Password:

Help |

= Back | Mext > I Cancel |

4
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You will have to also add root as the username, as well as the ap-
propriate password for the root user on the host you want to add.

2. Click Next to add the host.

3. Click Yes when presented with a security alert. This alert is
shown because a self-generated, self-signed certificate (provided
by VMware), which has not been trusted by the Windows system
yet, has been installed on the host installation.

4. The Add Host Wizard will show a summary of the ESX or ESXi
host you are adding and any virtual machines that may already
reside on it (see Figure 3.38). Click Next.

Figure 3.38: Hostinformation

(5] Add Host Wizard L -0ix]
Host Information
Review the product infarmation For the specified hast.
Connection Settings You have chosen ta add the Following host to wCenter:
Host Summary
Assion License Mame: esx40a,jasemccarty.com
Wirbual Maching Location Hendey ilviare, Inc,
Model: Whware virtual Platfarm
Reseytioipbs Yersian: Yhtware ES% 4.0.0 buiid-140815
Wirtual Machings:
4] 3|
Help < Back | Mext = I Cancel |
4

5. You will now be prompted to add a license key. If you have not
installed your licenses, you can choose Evaluation Mode, as
shown in Figure 3.39. Click Next when finished.

6. On the next screen
for the host’s VMs.

(shown in Figure 3.40), you specify a location

Building a VMware
vSphere Environment
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Figure 3.39: The Assign License screen

[ Add Host Wizard

Assign License
Assign an existing or a new license key to this hast,

=101 x|

Connection Settings
Host Surmary.

1# {As5ian an existing license key to this Nost &

Assign License
Wirtual Maching Location
Feeady to Complete

Product
= Evaluation Mods

| Awailable |

@) (Mo License Key)

" Assign a new license key ko this host

Enterkey. | |
Product: Evalustion Mode
Capacity:

Available:
Expires: S{10f2009
Label:

Help

= Back. | Mext = I Cancel |

4

Figure 3.40: Specifying a location for the host's VMs

virtual Machine Location
Select a location in the wCenter Server inventory For the host's virtual machines,

1ol x|

i-onnection settings Select a location For this host's virkual machines.

Host Summary
fssign License
Virtual Machine Location

Ready to Complete

4 | InstantRefBook.

% Back

Help |

D Next» |

7. Ifyou chose to put the host in an existing cluster in the previous step,

the next screen (Figure 3.41) asks you to specify a location for your

host’s VMs in the resource pool hierarchy. Once you do, click Next.

8. On the Ready To Complete screen (Figure 3.42), click Finish to
add the host to the datacenter, and if you specify one, the selected

cluster.
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Figure 3.41: The Choose The Destination Resource Pool screen

Add Host

rd =l0x|

Choose the Destination Resource Pool
Choose where ko place this host's virtual machines in the resource pool hisrarchy,

Gnnerinh SRS —Wirtual Machine Resources

Host Summary.

Assign License Wwhat would you like ko do with the virtual machines and resource pools for this
hast?

Choose Resource Pool
Ready to Complete % put all of this host's virtual machines in the custet's root resource pool.
Resource pools currently present on the host will be deleted.

" Create a new resource poal For this host's virtual machines and resource
paols. This preserves the host's current resource poal hierarchy,

Name: IGrafted From esx40b.jasemccarty, com

Help < Back | Mext = I Cancel |

4
Figure 3.42: Click Finish on the Ready To Complete screen.
Add Host rd = =]
Ready to Complete
Reeview the options you have selected and click Finish to add the host,
Connection Settings
Hast Summary Review this summary before finishing the wizard,
Assign License Fifet R 7
z 2 ost: esxd0a.jasemccarty. com
S L Version:  Wlware ESX 4.0.0 buikd-140815
Ready to Complete Metworks: WM Mebwork
Datastores: Storagel
-
Help = Back Cancel
4
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Now that you’ve added a host to the cluster, your work is not done.
Clusters are only useful when the cluster contains more than one host.
You can add one or more hosts to the cluster using the same steps.
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